Characterization of Catalysts and Surfaces

Elemental Analysis
(ICP, AAS etc.)

Fall Semester 2016

Bodo Hattendorf
HCI G105
bodo@inorg.chem.ethz.ch

FEldgendssische Technische Hachschule Zarich
<

°
Laboratorium fiir anorganische Chemie ~ o "

%

Federal Insttute of Technology 2urich il

Spurenelement- und Mikroanalytik vL

%o

Common Aspects

e Solution-based Techniques
- Usually aqueous
- Usually acidified (HNO5, HCI; 1-10 Vol.%)
- Digestion of solids required

e Calibration required
- External standards / Standard Addition
- Matrix-matching may be required
- Internal standards (when applicable)
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Atomic Absorption
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Outline

e Instrumental Methods for Determination
of the Elements
- Atomic Absorption Spectrometry - AAS

- Inductively Coupled Plasma Optical
Emission Spectrometry - ICPOES

- Inductively Coupled Plasma Mass
Spectrometry - ICPMS

e Sample Preparation Techniques
e Considerations for Quantitative Analysis
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Atomic Absorption Spectrometry

Gaseous atoms can absorb electromagnetic radiation
corresponding to the AE of their electronic states
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Atomic Absorption Spectrometry

The magnitude of this absorption is given by Lambert-Beer‘s law:

I: Intensity registered in presence of an

—g,Lc absorber (analyte atom)
A

I = I e o: Intensity registered in absence of an
0 absorber (analyte atom)

;.1 Absorption coefficient

: Wavelength registered

: Observation path length

: Concentration of the analyte

: Extinction (evaluated signal)

E= Igll—0 =¢,lc

mor >

AAS (and ICPOES) operate in the UV-VIS range, = 200 - 800 nm
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Atomic Absorption Spectrometry

So what do we need for an AAS
Experiment?

1) Gaseous Atoms - Flame or Furnace

2) Photon source - line- or continuous
(ideally resonant hv) (HCL, EDL or arc)

3) Optical Spectrometer

(Monochromator, Detector)
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Atomic Absorption Spectrometry

Line Sources
Element-specific emission spectra

Hollow Cathode Lamp Electrodeless Discharge

HCL Lamp
EDL
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Atomic Absorption Spectrometry

Spectral Interferences

Absorption (atomic or molecular)

Scattered radiation

- Background correction required:
D2 Lamp, Zeeman-effect
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Atomic Absorption Spectrometry

Flame Atomizer
Oxidants: Air, N,O, O,
Fuel: Acetylene, H,, CH,, C5Hg

Furnace Atomizer
Electrically heated up to 2700 °C
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Atomic Absorption Spectrometry

Rotierende FI. Monochromator
Sektorblende K ‘af" ey
i i Eintrittsspalt

| i " Spiegel

Spiegel|

Hohlkathodenlampe
e 1
Detektor
Verstérker i

Low-resolution Spectrometer
(44:0.1 -1 nm)

Austrmsspalt

Extinktion
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Atomic Absorption Spectrometry

Limited dynamic range

Small change of I/I, when the extinction exceeds = 1
- Higher uncertainty of the concentration.

I/l
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Extinction
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Atomic Absorption Spectrometry

Flame AAS Principle

Sample is nebulized and aerosol transferred to burner.
Optimization:

Fuel/Oxidant gas flow rates

Observation height

A i

Schlitzbrenner

Temperature
Particle formation
Residence time

Zerstaubungsgas Hn\ligas
4

° l_,_q— Brenngas
¥
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Atomic Absorption Spectrometry

Characteristics
Flame AAS Furnace AAS
Sample Volume mL pL
Analysis Time seconds minutes
Calibration? Ext./Std.Add. Std.Add.
Limits of Detection2 0.1 - 1000 ug/L 0.001 -10 ug/L
Repeatability3 1-5% 1-5%

1: Ext: External Calibration, Std.Add.: Standard Addition
2: Depends on Element, Matrix, Analysis Time
3: For Concentrations > 100xLOD
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ICP-Optical Emission Spectrometry

Setup —

fireball

Nebulizer Gas: ~ 1 L/min Ar inguction coil
Auxiliary Gas: 1 L/min Ar o
Coolant Gas: = 14 L/min Ar

spactrameter

radiofreauency
generator

Rf-Power: 1000 -1500 W
Rf Frequency: 27, 40 MHz

Soolant gas = ) roreh
auxiiary gas »

Sample uptake: = 1 mL/min ampte comnggar

i ici . - o capiliiar;

Nebulizer Efficiency: 3 - 5 % oeiliary nebuliser

poristaitic

—-- soray chamber

_sample to drain
solution
o

°
Laboratorium fiir anorganische Chemie ~ o "
Spurenelement- und Mikroanalytik V'La :o

Fidgentissische Technische Hachschule Zarich

Swiss Federal Institute of Technelogy Zurich o

Atomic Absorption Spectrometry

Furnace AAS %

Sample is pipetted into furnace (addition of modifier) and
T-program started.
Optimization:

T-program: Drying, Ashing, Atomization, Cleaning

Modifier type and amount o0

Separation of Analyte 2500 C'ﬂ
from sample matrix and = = o
Solvent. £ ism m| \
Efficient vaporization. & 1000 Aok I
500
Common Modifiers: oyl \_
Mg(NO3),, Pd(NO3),,NH,H,PO, N » 40 @ ®
time (sec)
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ICP-Optical Emission Spectrometry
ICP: Inductively Coupled Plasma
An Rf-powered electrodeless gas (Ar) discharge,
reaching Temperatures of 10000K
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ICP-Optical Emission Spectrometry

Characteristics

Sample aerosol is injected in a narrow region (2 mm) of
very high Temperature:

- Efficient atomization
- Ionization
- Generation of electronically excited Atoms and Ions

Relaxation of excited states leads to detecable 0
emission signals

000

Laboratorium fiir anorganische Chemie o

oa,

a ) =

Spurenelement- und Mikroanalytik o
o

Fidgentissische Technische Hachschule Zarich

Swiss Federal Institute of Technelogy Zurich o



ICP-Optical Emission Spectrometry
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ICP-Optical Emission Spectrometry

ICP Background Emission
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ICP-Optical Emission Spectrometry

High-resolution Optical Spectrometers required

a0 P 2 a3 s s

wanalongih, nm wavslengh, rm

Identification and Correction of Spectral interferences
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ICP-Optical Emission Spectrometry

Elemental Species vs. T

as

%OOO 4000 5000 &000 7060 BOO0 SO00K
._El"_'l' ) ) Laboratorium fiir anorganische Chemie ~ o° ° %
ot e ottt of Techmtogy Lo Spurenelement- und Mikroanalytik 7o v

ICP-Optical Emission Spectrometry

High-resolution Optical Spectrometers required

AL: = 10s of pm

Polychromators providing simultaneous
access to the UV-VIS spectral range
(~130/180 - 800 nm)

- Paschen Runge Setup

- Echelle Configuration

Monochromators
- Czerny Turner Configuration
(barely used in current instruments)

o

Fidgendssische Technische Hochschule Zarich
‘Swiss Federal Institute of Technelogy Zurich

%o
Laboratorium fiir anorganische Chemie ~ o o
e

o

00

Spurenelement- und Mikroanalytik v,L

ICP-Optical Emission Spectrometry

Simultaneous Spectrometers advantageous

a0 P 2 a3 s s

wanalongih, nm

wavslengh, rm

Correlated acquisition allows for better compensation of fluctuating
baseline and interference signals.

« Internal Standard(s) can be itored simult 1

Fidgentissische Technische Hachschule Zarich
Swiss Federal Institute of Technelogy Zurich

°
Laboratorium fiir anorganische Chemie o "
Spurenelement- und Mikroanalytik an :o

o



ICP-Optical Emission Spectrometry

Pneumatic Nebulizer
(aerosol generation)

©
%D} =
4 : | —- e -

Spray Chamber
(removal of large droplets)
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ICP-Optical Emission Spectrometry

Optimization
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@ |—Mg 1 285.213 / \
£ 100 |—2n 11 206.200
é /
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°
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Nebulizer Gas Flow Rate, L/min
I: Atom Line, II: Ion Line
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ICP-Optical Emission Spectrometry

Effects of Increasing Plasma Temperature:
« More efficient vaporization and excitation
» Higher Analyte Signal
> Less Matrix Effects
» More Potential Spectral Interferences
« Increasing degree of ionization
> More intense Ion Lines
> Less intense Atom Lines
> More Potential Spectral Interferences
+ Increasing background emission
» Lower Signal/Noise

« Mechanical Stress / Erosion of the Torch
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ICP-Optical Emission Spectrometry

Plasma View: Radial vs. Axial

Robust against Matrix
Simpler Setup
Lower Analyte Sensitivity

= 10x higher Sensitivity

Lower Background

Better LODs

Stronger Matrix Dependence
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ICP-Optical Emission Spectrometry
Optimization
200
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ICP-Optical Emission Spectrometry

Typical Limits of Detection

Pneumatic Nebulizer, Radial Plasma View

D > 10 png/! He
Be| [ 110w/ B]cIN[O[F Ne
Mg [ 011w Allsi|P|s [cllar
Ca|Sc|Ti| V |Cr|Mn|Fe|Co|Ni|Cu|Zn|Ga|Ge|As |Se Br Kr
Sr|Y |ZrNbMo| Tc|Ru|Rh|Pd|Ag(Cd|In|SniSb[Te| I Xe
Cs|Ba| |HfTa|W Re|Os|Ir Pt AuHg|TI|Pb|Bi|Po|AT|Rn
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ICP-Optical Emission Spectrometry

Limitations:

+ Sample Composition can Influence Emission Signal
> More pronounced with Axial View
» Enhancment and Suppression can occur

» Line-rich Spectra from many Transition Elements
» Interference Control Mandatory
> Background Signals may vary between Samples

+ Deposition of dissolved Solids can cause Memory Effects
» Long Rinse Times
> Application-Specific Sample Introduction Systems
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ICP-Mass Spectrometry
Setup

Vacuum Interface

Differentially pumped Vacuum System
Sample Introduction
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ICP-Mass Spectrometry

Intrumental Background
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ICP-Mass Spectrometry

Ton Extraction from a 5000 K Source
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ion signal, cps

ion signal, cps

Induction
Coil
Plasma Torch Q2 4
Sample Aerosol
\

Coolant Gas
Plasma Gas

ICP-Mass Spectrometry

Why ICPMS?

Eventually lowest instrumental background

High ion yield for most elements
- Low Limits of Detection

Less, and easier to predict spectral inerferences

Isotope Information
Various Sample Introduction Methods

Up to 12 Orders of Magnitude Linear Dynamic Range
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Spurenelement- und Mikroanalytik

Laboratorium fiir anorganische Chemie
Spurenelement- und Mikroanalytik

to High Vakuum

Sampler Cone

o
o

®o

A

o e
o s
oae

00
07 %

o
° o
=
000

180

100 4 [za] m/z
107
108 o e,
10! N Kr
104 o i
10% 4, NNON: Ay K,K' e o
102 -
haITT ||| i ‘ I
miz
104 -
10° % xo
1D2 B
o ol L1 L1
120 150 160 170
miz



2 o
i’- HuHu

T 9

o

2 L0 lhﬁmlmu L1

2 180 190 200 210 220 230 240

miz

Typical Background Contributions:
>Plasma Gas: Ar*, Ar,* Ar9+ etc.

> Impurities in the Gas and ambient Air:
C*, N+,0*,H,0* Kr+, Xe*, (Hg*, Sn*, Pb*)

- Deposits in Torch, Interface:
Alkaline Metals (e.g. Na*), Sample Matrix, Si*

- Molecular and Cluster Ions:
Cy*, No*, GOy, NO*H, AryH,*, ArC,*, ArN,*, ArO,*,
ArN,*.....
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ICP-Mass Spectrometry

MS Types
Quadrupole MS: Ion Transmission: Moderate
Mass Resolving Power: 0.7 m/z

Acquisition: Sequential (0.1 ms / peak)
——

Sector Field MS:

Ion Transmission: High

Mass Resolving Power: 300 - 12000
Acquisition: Slow Sequential

(0.1 ms - 300 ms/ peak)

Time of Flight MS: Ion Transmission: Moderate

e, - Mass Resolving Power: %4000
— T, Acquisition: Simultaneous
- — Measurement Speed:0.033 ms / Spectrum
S (e
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ICP-Mass Spectrometry
"“"High Mass Resolution” with Quadrupole MS
Chemical manipulation of the Ion Beam Composition:
Ion-Molecule Reactions, MS-MS mode
0, Reaction gas R
1o,
s2ge - ngléo
o oz '
m/Q 32 Bandpass
S+ 325+ > 3250+
0, 0,* » 05"
m/z 48
removed
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ICP-Mass Spectrometry

Ion Yield

2 100 1 ion detected
H -

2 requires

€ 10t 20000 atoms

5 in the source

g

8 10°
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10€
[} 50 100 150 200 250
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ICP-Mass Spectrometry

High-Resolution Advantage

At least 5 different Species in a 1 m/z Mass Window

520+
40Ar12CH 52Crt:

105 36Ar160+

3BAF2CH,*

102
; ‘|
518 52.0

51.93996
40Ari2C+: 51.961833
S6Ari6O*:  51.961911

38Ar12CH,*: 51.977832

Intensitat, cps
2

100 —

m/z

o
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ICP-Mass Spectrometry

Limitations
Matrix Effects are more severe:

> Spectral Interferences

o Limits the Choice of Solvents
(H,S0,, H3PO, should be avoided, HCI only when absolutely needed)

» Deposits at Vacuum Interface can cause Instrument Drift

o Limits the Content of dissolved Solids
(1 g/L generally considered maximum)

> «Space Charge» Effects from high Ion Currents
» Changes in Ion Yield:
o Signal Suppression (e.g. Easily Ionized Elements)

o Signal Enhancement (e.g. changes in Space Charge)
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ICP-Mass Spectrometry

Typical Limits of Detection

Pneumatic Nebulizer, Quadrupole MS, Aqueous Samples

ﬁ D > 100 ng/L He
Lige [>1non BIC/N|O[F Ne
NaMg []<1ngt AllSi|P |5 |cl|Ar

Km&ﬁwam&ammha@n&wm
Rb\Sr|Y |Zr NbW\o Tc|Ru|Rh|Pd|AgiCd |In|SniSbTe | I Xe
Cs|Ba| |Hf[Ta|W Re|Os|Ir|Pt AuHg Tl Pb|Bi Po Af|Rn

Lal|Ce|Pr Nd‘Pm 5@ Eu|6d[Tb|Dy[HolEr Tm‘Yb Lu
Ac[ThPa [U ‘Np Pu ‘ArnCm Bk|Cf|Es Fde‘No Lr

o
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Calibration

Methods

» External Calibration

o Synthetic Solutions of the Analyte(s)

o Matrix-Matching may be required

o Internal Standards recommended (ICP-based methods)
» Standard Addition

o Addition of Synthetic Solutions of the Analyte(s) to Aliquots of
the Sample

o Ideal Matrix-Matching
o Time-consuming

» Isotope Dilution
o Only with MS

ETH Laboratorium fiir anorganische Chemie ;“;aa
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Calibration
External Calibration
3.5x10°
I | fa 3.0x10*
— b= Intensity (ratio) in
[ =]
C, = 5 0 52510 sample (I,) Ar
0
— 2.0x10*
- Ac
Al = 15x101
@ L
S = — <
AC
™ 5.0x107 Concentration
in Sample (Cp)
0
0.0 05 10 15 20
Concentration (-Ratio)
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ICP-based Spectrometries

Characteristics
OES MS
Sample Volume mL pL-mL
Analysis Time seconds seconds
Matrix Tolerance! high (%) low (<0.1%)
Calibration? Ext./Std.Add. Ext./Std.Add./ID
Repeatability3 1-5% 1-5%
Dynamic Range 106 10°-1012

1: Values in Brackets indicate the tolerable Dissolved Solids Content
2: Ext: External Calibration, Std.Add.: Standard Addition, ID: Isotope Dilution
3: For Concentrations > 50xLOD

o

ETH Laboratorium fir anorganische Chermie s
Fidgentissische Technische Hachschule Zarich °
Swiss Federal Institute of Technelogy Zurich

Spurenelement- und Mikroanalytik vL

°g
o
/
]
o
000

Calibration

External Calibration

Known Amounts of Primary
Standard(s) are filled into clean
vials

(eventually with an Internal Standard)

Ideal to use different Supplies

Dilution to desired Concentration
using a suitable Solvent

Mix!
Blank Cal 1 Cal 2 Cal 3 Cal 4
'E'H Laboratorium fiir anorganische Chemie ;“;aa
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Calibration

External Calibration

+ Simple

+ Practically all Elements accessible

+ Practically all Sample Types accessible

+ Internal Standard can be easily included

+ Concentration range only limited by Solubilities

- Spectral Interferences need to be absent or
corrected for

- Matrix Effects and Instrument Drift have to be
monitored and corrected for

ETH °
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Calibration

Standard Additions

Sample splitted to identical
Aliquots
-2 minimum 3, ideal 5

Addition of known amounts
of a Standard Solution

Dilution to desired
Concentration using a suitable
Solvent

1
i
:
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Calibration

Standard Additions

IMEP- 16: Pb in wine
Certified value : 27.18 £ 0.33 gL [U=k-u, (k=2)]

" -
! [m] f l .
T T *
. 1s &
H { +" :
Lo | A a2 d l | H
27.15+0.45 ug/L T l ,I.T-lg g H
. =5
.
a
o W
i w
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Calibration
Al
Isotope Dilution (MS only) al
Unknown Sample with «Natural» m/z
Isotope Ratio al
Isotopically enriched Standard
AL
m/z
Aliquots of exactly known
amount are mixed
m/z
Dilution to desired Concentration
using a suitable Solvent
Mix!
m/z
ﬂ’_‘l’m e Laboratorium fiir anorganische Chemie o:y_j«;
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Calibration

Standard Additions

Round Roin Test

| IMEP-16, IRMM
CP =20 Pb in Wine
S 3.0x10%
S = Al 2.5x10°
w
AC S 20100 AT
fg 1.5x10° Aac
27.15+0.45 ug/L 5 .
2 10
5 I,
10¢
ETH 0 30 20 -0 0 10 20 30 40 50 60
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Standardaddition, ug/L

Calibration

Standard Additions

+ Matrix Effects can be eliminated

Spectral Interferences need to be absent or
corrected for

Labour intensive
- Approximate Concentration needs to be known
Long measurement times

Instrument Drift is not compensated for
(may require another internal Standard)
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Calibration
Isotope Dilution (MS only) :
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Calibration

Isotope Dilution (MS only)

+ “Goldstandard” of Calibration

+ Optimum internal Standard

+ Ideal Compensation of Matrix Effects
+ SI-Traceable

- High experimental Effort
- Not Applicable with Mono-Isotopic Elements

- Spectral Interferences must be absent or
corrected for

- Enriched Standards not readily available
- Instrument Drift not easily compensated for

Fidgentissische Technische Hachschule Zarich
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Sample Preparation

Organic Solvents
High variability of Viscosity, Surface Tension and
Evaporation Rates causes issues with Nebulization
-> Sample uptake Rate needs to be controlled

Calibration Standards not readily available

ICP methods are less tolerant to Organic Solvents
-> Digestion

-> Addition of trace amounts O, to the ICP to avoid
Soot formation
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Sample Preparation

Common Digestion Methods

Microwave assisted High Pressure, High Temperature
Digestion
- Temperature up to 200 °C, Pressure up to 200 bar
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Sample Preparation

Aqueous Solutions

Stabilization of the Elements in Solution

- Usually Acidification with HNO;
(Saturation of Cation-Exchange positions of the
Container and Sample Introduction)

- Specific Stabilizers may be required, depending
on Chemistry

Dilution to suitable matrix concentration
- Depends on Analytical Method
Addition of Internal Standard(s)

'_ﬂ,_' ) Laboratorium fiir anorganische Chemie o °;4;
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Sample Preparation
Solids
Conventional Methods require Digestion using a suitable
Reagents

Most frequently an Acid Cocktail
> HNO; (HCI, HF if necessary; H,SO, should be avoided)

Suitable Digestion Methods are available for most Materials

> Reagents and Digestion Vials need to be of sufficient
Purity

Direct Solids analysis using Laser Ablation ICPMS or Solid
Sampling GFAAS

Fidgendssische Technische Hochschule Zarich

. . . 600
Laboratorium fiir anorganische Chemie ~ o o
e
‘Swiss Federal Institute of Technelogy Zurich oao’

Spurenelement- und Mikroanalytik ¢

Sample Preparation

Common Digestion Methods

Oven-heated High Temperature, High Pressure
Systems
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Sample Preparation

Common Digestion Methods
All Material in Contact with Sample and Reagents
must be Inert and Clean
- Mostly Fluoropolymers: PTFE, PFA, etc.
> (Quartz)

Evolution of Gas (e.g. Oxidation of Organic Material)
can lead to sudden Pressure Jump
> Sample loss via the Safety Relief Valve /
Rupture Disk
> Potential Safety Hazard
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Sample Preparation

Direct Solid Sampling with LA

a)ALO, ). osio,
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2-D and 3-D Element Distributions at 5 um Spatial Resolution
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Method Development
Sources of Error in Trace Element
Analysis
S s Spuendement- nd ot

Sample Preparation

Direct Solid Sampling with LA

Mikroscope/Camera

Laseroptik

1
L] T

Sample Cell

5 Argon or Helium %
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Method Development

Considerations

Accuracy of the Analysis
Concentration Range
Techniques used
Reproducibility

Sample Throughput

Cost
ETH
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Method Development

Sources of Error in Trace Element
Analysis

Calibration 10%

—__ Interferences 11%

™

Instrument 8%

Sample Preparation 30%

User 15%

Contamination 26%
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Method Development

Time Spent

Instrumental Analysis 6%

\\ Data Processing 27%
N

Sample Preparation 61%

Sampling 6%
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Method Development

Validation

Ensuring Representative Analytical Results

- Validate Representativeness of Subsamples
Sampling Theory
- Validate Accuracy of Calibration
Recovery Check Analyses
Serial Dilution
Matrix Evaluation
Analysis of Certified Reference Materials
- Evaluate Reproducibility of Results
Dupli Analy (r ized)
Repeated Calibration
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